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1. Getting Started 

1.1. Aim of EVAL2 

EVAL2 is a tool for analyzing measured files (extension ssd). 

The program consists of two main parts, graphical evaluation and quantitative evaluation: 

 If a sample is measured in scan mode the software offers options for graphical 
evaluation and interactive work. Elements are identified and labelled automatically. 
There will be produced a qualitative result. 

 

 

 In the quantitative part of EVAL2 various functions and features to calculate results 
from the measured intensities are offered. Important parameters like sample 
preparation and calibration files can be checked and if necessary be modified. 

 

  



 

 

 

At the completion of a measurement, the concentrations are automatically computed ; this 
is the Automatic Evaluation. In X-ray fluorescence, it is necessary to give a physical 
model of the sample in order to calculate these concentrations. Some hypotheses are 
mandatory (e.g. the sample must be homogeneous); some other can be adjusted: 

 the preparation parameters; 

 the concentration of the elements that are not measured, or that are also measured 
with another analysis method; 

 the line used to evaluate the elements. 

Some of the parameters can differ between the unknowns and the standard samples. In 
case of standardless measurements, the software cannot know some of these 
parameters. SPECTRA EDX therefore gives the possibility to modify these parameters 
and make a new evaluation — this is the Interactive Evaluation. 



 

 

 

1.2. Interaction with the other SPECTRA EDX files 

When a calibration is done, the calibration coefficients can be stored: 

 in the line library (SX-LineLibrary.FLL), in case of the default calibration for the lines; 

 in a calibration file (FCL file). 

When performing an interactive evaluation, QUANTEVL2 retrieves the default parameters 
for the evaluation from the application (evaluation model, EVM file), the Results database 
(Measure.MDB) and the line library (SX-LineLibrary.FLL). The intensities that will be used 
for the evaluation are stored in a SSD file. 

Once the evaluation performed, it can write the result in the Results database 
(Measure.MDB). 

  



 

 

 

1.3. Starting EVAL2 

You can start EVAL2 from: 

 
Spectra Launcher 
icon 

 The SPECTRA EDX Launcher: 

1. start the SPECTRA EDX Launcher; 

2. when no SPECTRA EDX session is running, a warning message appears; click 
OK, then in the SPECTRA EDX Login dialog box, type your User name and 
Password and click OK; 

 
Evaluation button 

3. the SPECTRA EDX Launcher dialog box appears; click Evaluation; 

4. the Select Sample(s) for Evaluation dialog box appears (see section 3.1 "How to 
import a sample"); once the sample is selected, click Interactive quant or 
Interactive quali. 

 

Fig. 1-3 SPECTRA EDX Launcher dialog box 

 

Fig. 1-4 SPECTRA EDX Login dialog box 

Like for any other Windows
®
-based application: 

 
EVAL2 icon 

 EVAL2 can be launched from the Windows
®
 Explorer or My Computer, by double-

clicking the icon. 
EVAL2.EXE is in the drive and folder set during installation. If you used the default 

setup, it is in C:\Program Files\SpectraEDX\ 

 

  



 

 

 

2. EVAL2 windows and documents 

2.1. Overview of the EVAL2 windows 

 

Fig. 2-1 EVAL2 window 

The EVAL2 window consists in five parts: 

 the Title bar, which contains the name of the selected Document window; 

 the Menu bar, which contains all the commands; 

 the Toolbar, with the shortcut buttons to the most important commands; 

 a Document window, which can be a Quant window or a Quali window; 

 the Status bar, which displays the calculation status. 

 
Alternative mode 
window button 

The Alternative mode window button allows switching between the various Quant and 
Quali windows of an EVAL2 document. The CTRL+F6 and CTRL+TAB key combinations 
can also be used to switch from a window to the other, including between EVAL2 
documents. 

 
Restore button 

The Restore button puts the Document windows (Quant and Quali windows) in the 
"cascade" display mode. It is then possible to click directly in the window of interest. 

 
Maximize button 

Click the Maximize button of any Document window to get back to the initial display 
mode. 

 

To know more about see 

the Document windows section 2.3 

 

2.2. EVAL2 documents 

Overview of the EVAL2 documents 

An EVAL2 document is a composite document that can contain: 

 raw measurement data (e.g. a copy of SSD files); 



 

 

 

 evaluation data: 

 parameters for the quantitative evaluation and its result: the initial application 
(EVM file) and the adjusted parameters (fixed concentration, chemical bonds, 
matrix…), calculated concentrations; 

 parameters for the qualitative evaluation and its result: chemical filter, 
energy/wavelength range, found elements… 

 graphical parameters: color of the spectra, zoom, labels… 

In the EVAL2 window, the EVAL2 document is displayed as one or several Document 
windows. There are two types of Document windows: the Quant windows and the Quali 
windows. By default, an EVAL2 document is made of a single Quant window. 

The EVAL2 documents are saved in files whose file name extension is .EVAL2 

e.g. the doc1 document is stored in the doc1.EVAL2 file. 

By default, the name of the document is the sample ID of the first imported sample (see 
section 3 "Importing a sample"); it can be changed when saving the document. 

 

To know more about See 

The EVAL2 window section 2.1 

The Document windows (Quant and Quali windows) section 2.3 

How to save an EVAL2 document section 2.2.2 

 

Managing documents 

The usual procedure is: 

1. create a new EVAL2 document 
— or — 
open an existing document. 

2. import one or more samples. 

3. process the data (quantitative or qualitative evaluation). 

4. print the result, save the result in the Results database and/or save the EVAL2 
document. 

5. close the EVAL2 document. 

  



 

 

 

The present section is about creating, opening, saving and closing an EVAL2 document. 

To know how to See 

Import a sample section 3 

Perform a quantitative evaluation section 4 

Perform a qualitative evaluation section 5 

Print the result and save it in the Results database section 5.6 

 

Creating a new document 
An empty document is automatically created when EVAL2 is opened. 

To create a new empty document: 

 click the New command in the File menu 
— or — 
use the shortcut key combination CTRL+N 

 

Opening an existing document 
When an EVAL2 document was saved (see below ), it is possible to retrieve it. 

To open an existing EVAL2 file: 

 1. click the Open command in the File menu 
— or — 
use the shortcut key combination CTRL+O; 

2. in the Open dialog box, browse to the directory where the file was saved; 

3. select the EVAL2 file and click Open. 

 

Saving a document 
It is possible to save an EVAL2 document, e.g. when it is not possible to process the data 
in a continuous session, or to be able to reprint the spectra with the same layout. 

To save a document with the current document name: 

  click the Save command of the File menu 
— or — 
use the shortcut key combination CTRL+S; 

To save a document with a different name: 

1. click the Save As command of the File menu; 

2. in the Save As dialog box, select the file path (directory) where the file will be saved; 

3. in the File name text box, type in the name of the file; the .EVAL2 file name extension 
is automatically added; 

4. click Save. 

 

Closing a document 
Several documents can be opened at the same time in EVAL2. However, to avoid errors 
(e.g. performing an operation on the wrong document), it is recommended to close a 
document before opening a creating another one. 

To close a document: 



 

 

 

 
Close button 

 click the Close command of the File menu 
— or — 
close all the windows of the document with the Close button in the Menu bar when 
the windows are maximized, or in their Title bar when they are in cascade mode (see 
section 2.1 "Overview of the EVAL2 windows"). 

 

 

  



 

 

 

2.3. Document windows 

A Quant window is a window used for the quantitative evaluation, i.e. the calculation of the 
concentrations from the measured spectrum and the Application.  

A Quali window is a window used for the graphical display of the spectrum and the 
qualitative evaluation, i.e. the detection of the elements from the spectrum. 

By default, an EVAL2 document is made of a Quant window. 

Another Quant window can be added, e.g. to compare several quantitative evaluation. To 
do this: 

 in the Window menu, choose New Quant window. 

A Quali window can be added in one of the following ways 

 
Alternative Mode 
Window button 

 in the Window menu, choose New Quali window; 
— or — 
in a Quant window, click the Alternative Mode Window button. 

The name of the window is written in the Title bar: the Title bar of the EVAL2 window 
when the document windows are maximized, or the Title bar of the document window 
when they are minimized or in adjustable size mode. The name of the window is: 

[Mode] - [Document name:n] 

where 

 Mode is "Quant" or "Quali", depending of the type of window; 

 Document name is the name of the EVAL2 document; 

 n is the number of the window in the order of creation. 

To switch between the different windows of a document: 

  
Alternative Mode 
Window button 

 use the CTRL+F6 or CTRL+TAB key combination 
— or — 
click the Alternative Mode Window button. 

To close a document window: 

 
Close button 

 click the Close button in the window Menu bar when the Document window is 
maximized, or of the Title bar of the Document window when it is in cascade display 
mode (see section 2.1 "Overview of the EVAL2 windows"). 

 

  



 

 

 

The Quant windows 

The main part of a Quant window is the Concentration list, i.e. list of calculated 
concentrations with additional information. 

Some buttons of the EVAL2 Toolbar are specific of the Quant windows and are disabled 
for other windows; these are shortcuts to the commands of the Quanti and View menus. 
Other commands are accessed with a right-click the items of the Concentration list 
(context-sensitive menu). 

The color of a line changes with its status: the compound is in blue when it is a matrix, 
and in red when it is fixed to zero. 

 

 

Fig. 2-2 Quant window 

Columns of the Concentration list 

Column name Description 

Formula chemical formula of the compound 

Z atomic number of the key element of the compound 

Concentration concentration of the compound in the sample 

Status the way the compound is evaluated:  

Line n XRF line used for the evaluation 

Net Int. net intensity of the line n 

Calc. 
concentration 

concentration calculated with the line n 

Stat. Error statistical error on the intensity (fluctuation of the signal following the 
Poisson's law) converted into a concentration with the calibration coefficient 
and the matrix correction 

LLD lower limit of detection, determined from the background level (the smallest 
detectable peak must be above the fluctuations of the signal) 

Analyzed layer thickness of the sample that absorbs 90% of the intensity of the XRF line of 
interest 

 



 

 

 

2.3.2 The Quali windows 
The Quali window consists in a graphical window; it is possible to zoom in and out, to 
change the color of the objects… 

Some buttons of the EVAL2 Toolbar are specific of the Quali windows and are disabled 
for other windows. Other commands are accessed with a right-click the graphical objects 
(spectrum, Element stick), on the background or on the axis. 

 

Fig. 2-3 Quali window 

See also 

 section 5.2: "Creation of a Quali window and import of a spectrum" 



 

 

 

Organizing the windows 

EVAL2 uses "floating" windows for the most useful dialog boxes, i.e. 

 for a quantitative evaluation (with a Quant window): the Sample Properties and the 
Evaluation Methods dialog boxes; 

 for a qualitative evaluation or the graphical display (with a Quali window): the XRF 
Lines dialog box. 

It is possible to display and hide these windows at will, with the corresponding buttons or 
with the commands of the View menu. But it is also possible to keep them always 
onscreen, besides the main EVAL2 window; mind in this case that it is recommended to 
hide the windows of other programs, or the windows from the different programs may hide 
each others'. This all depends on your habits and on the size and resolution of your 
screen. 

 

Fig. 2-4 Example of the organization of the screen with a Quant window and Sample Properties and 
Evaluation Methods floating windows 

  



 

 

 

  

Fig. 2-5 Example of the organization of the screen with a Quali window and the XRF Lines floating window 

  



 

 

 

3. Importing a sample 

3.1. How to import a sample 

The first operation to perform is to import a sample, i.e. the SSD file corresponding to the 
measurement. When EVAL2 is opened by the SPECTRA EDX LAUNCHER, it 
automatically displays the Select Sample(s) for Evaluation dialog box; otherwise: 

  
Import raw data 
and Next 
document button 

 click the Import raw data or Next document button 
— or — 
use the Import raw data/Next document option in the File menu. 

There are two import buttons and two import options: 

 Import raw data, : this button permits to overlay the scans of different 
samples. It is useful for graphical work and overlay features; 

 Next document, : remove the former SSD file and replace it by the new one. 

 

Fig. 3-1 Select Sample(s) for Evaluation dialog box 

When the sample of interest is displayed in the list, click its line and then OK, or, if the 
evaluation was launched from the SPECTRA EDX Launcher, with the Interactive quant 
or the Interactive quali button. 

  

Fig. 3-2 Interactive quant and Interactive quali buttons in the Select Sample(s) for Evaluation window, 
when EVAL2 is launched from the SPECTRA EDX Launcher 

If you want to modify first the evaluation parameters (change the calibration file, the 
preparation or fix a parameter), click the Evaluation option button.It is also 
recommended to click this button to check the evaluation parameters any time you 
evaluate a sample. 

When it does not appear in the list, you can set different options to retrieve it: click 
Advanced search. 

Display option 



 

 

 

You can set which columns are displayed in the Sample list. For this: 

Advanced search 
or Default search 
buttons 

1. click Advanced search or Default search; 

2. in the Advanced Search or the Default Search Option dialog box, click the Sample 
list columns button; 
this displays the Select Samples List Column dialog box; the names of the columns of 
the Samples list are listed in the right list, in the same order as the display; the 
parameters, that are available but not displayed, are in the left list; 

 
Add button 

3. to add a column to the display, click the name of the column in the left list and click 
the Add button; 

 
Remove button 

4. to remove a column to the display, click the name of the column in the right list and 
click the Remove button; 

  
Up and Down 
buttons 

5. to change the order of the column, click the name of the column of interest on the 
right list, and click the Up or Down button. 

6. click OK. 

 

Fig. 3-3 Select Samples List Columns dialog box 

 

Error at the import 
The SSD file is retrieved through it path and name in the Results database. If the SSD file 
was moved, deleted, or its name changed, a "SSD file not found" error message appears 
in the Status bar and most commands are disabled. 

 

3.2. 3.2 Search options 

 
Default search 
button 

When the Default search button is used, EVAL2 searches in the Results database for samples 

that match criteria. These criteria can be set with two dialog boxes: 

 
Default settings 
button 

 the Default Search Options dialog box: it is displayed when you click Default 
settings; the criteria are used by default for all queries; 

 
Advanced search 
button 

 the Advanced Search dialog box: it is displayed when you click the Advanced 
search button; this dialog box allows setting the search options for one single search 
only. 



 

 

 

  

Fig. 3-4 Default Search Option and Advanced Search dialog boxes 

To set the default search criteria 

 
Default settings 
button 

7. display the Select Sample(s) for Evaluation dialog box (see the section 3.1 "How to 
import a sample"); 

8. click the Default settings button; this displays the Default Search Options dialog box; 

9. change the options; 

10. click OK. 

 
Default search 
button 

These options will be used when clicking the Default search button. 

 

 

To set specific search criteria for a single search 

 
Advanced search 
button 

11. display the Select Sample(s) for Evaluation dialog box (see section 3.1 "How to 
import a sample"); 

12. click the Advanced search button; this displays the Advanced Search dialog box; 

13. change the options; 

14. click Apply and Close. 

Description of the search options 
The following options are used to search in the Results database (Measure.MDB). The 
same options appear in the Default Search and in the Advanced Search Options dialog 
box. 

A single sample can be displayed several times: 

 if it was measured several times (with the same sample name); 



 

 

 

 
Save results 
button 

 if it was interactively evaluated; there is then one result for the automatic evaluation 
(at the completion of the measurement), and one for every interactive evaluation 
(when clicking the Save results button). 

 

Option Description 

Date sort the measurements by date; five options are available: 

 Measured today: only the samples measured the current day 

 Current week: only the samples measured the current week 

 Past x days: only the samples measured in the last x day 

 Past x samples: only the x last samples 

 No date/number limitation: the samples are not sorted by date 

Operator select only the samples measured or evaluated by a given operator 
(this is the login name of the SPECTRA EDX Login); there are four 
options: 

 Current: sample measured or evaluated by yourself 

 Measured by: in the list, choose the operator that was logged 
when the measurement was performed 

 Evaluated by: in the list, choose the operator that was logged 
when the interactive evaluation was performed 

 Any: the samples are not sorted by operator 

Evaluation status whether the sample was evaluated 

 Not yet evaluated:  

 All samples: 

 All occurrences of the same sample 

Applications name of the application (EVM file) 

 

4. Quantitative evaluation 
The aim of the quantitative evaluation is to compute the concentrations from the 
measured spectra, using a calibration (default calibration in case of a standardless 
method). In EVAL2, it is possible to adjust some parameters, i.e. to change interactively 
the application. 

The quantitative evaluation is performed in a Quant window (see section 2.3.1). 



 

 

 

 

Fig. 4-1 Quant window 



 

 

 

4.1. Principles of the evaluation 

This section gives an overview of the general principles of the evaluation, to show the 
integration of these concepts in EVAL2. Please refer to appropriate literature for details. 

 

Concentrations, intensities and matrix effects (theoretical background) 

When an atom is excited by an incident X-ray photon, its de-excitation emits an X-ray 
photon (or an Auger electron, especially for the light elements) with a specific energy; this 
emitted photon is called "fluorescent photon", and the energy is called the "specific line". 
The energy of the specific line only depends on the type of atom; each element can emit 
several lines. The rate of photon that is detected by the spectrometer depends on: 

 the rate of incident photon that strike the atom, 

 reduced by the absorption by the sample (primary absorption); 

 enhanced by the lines emitted by the neighboring atoms (over-excitation or 
secondary fluorescence); 

 the absorption by the sample of the emitted photons on their way out (secondary 
absorption.) 

The intensity of a line thus depends not only on the concentration of the atoms that emit 
the line, but also on the concentration of other atoms (absorption and secondary 
fluorescence). These effects are called the "matrix effects". 

This can be summed up by the Lachance-Traill formula (1966): 

 












 

ij

jijiii ccmI 1  

in which 

 i is the element of interest, ci is its concentration and Ii is the measured intensity of the 
line of i used for the evaluation; 

 mi is the calibration coefficient for the considered line; 

 the cj are the concentrations of the other elements j; 

 ij is an integral expression that depends on all the concentrations, and that 
represents the influence of j on the intensity measured for i; it is called "inter-element 
coefficient" or "matrix coefficient". 

This formula is derived from the Sherman's equation (1955). 

It is easy to compute the intensities knowing the concentrations, but the contrary requires 

 either to consider that the alpha coefficients are fixed; this is the "Fixed Alphas" 
method; 

 or to use an iterative calculation algorithm; this is the "Variable Alphas" method. 

The Variable Alphas method computes the alpha coefficients from the concentrations 
(estimated by the previous iteration) and from the fundamental parameters (absorption 
coefficients, fluorescence yield…). 



 

 

 

The basic equation to calculate the concentrations from the measured intensities is: 

)1(10 



ji

jiji CIAAC   

in which 

 Ci  is the element concentration and I the measured intensity of the corresponding 

line; 

 the Cj are the concentrations of the other elements j; 

 A0 and A1 are the coefficients of the calibration regression line, respectively offset 

and slope. They are stored either in the Line library if a default calibration is used or in 
the calibration file if a specific calibration is used;  

 ij are the interelement matrix coefficients. They can be calculated “theoretically” 

based on “fundamental” physical values like absorption coefficients and secondary 
fluorescence enhancement 

This a simplified model of the physical reality. 

The calculations are performed as follows: 

 Step 1: 

IAAC  10  

 Step 2: 

)1(10 

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ji

jiji CIAAC   

And so on! The iteration cycles are performed as long as the compared iteration steps are 
below a given value. 

  



 

 

 

Evaluation of the intensities 

The spectrometer records a "number of counts" N versus 2, the position of the detector. 

This 2 position can be converted in the wavelength  of the radiation with the Bragg’s 
law, and in the energy the photons E (the energy of the photons and the wavelength of the 
radiation are linked by the Planck's constant). 

The number of counts is assumed to be proportional to the number of photons (linearity of 
the detector); the proportionality factor determines the sensitivity of the spectrometer for a 
given energy. The number of counts is divided by the measurement time t to give the 
count rate I, or intensity. 

A spectral line is represented by a peak in the (2,I) diagram (spectrum). The intensity is 
normally the net height (i.e. gross peak height minus background height); in some cases, 
the gross height can be used. 

 

Fig. 4-2 Evaluation of the intensity by the net height 

 

The peak and background can be determined in two ways: 

 when the sample is measured in fixed position, one point gives the gross height, and 
one r several points give the background level; 

 when the sample is measured in scan mode, a parabola is adjusted (fitting) to the 
peak to determine the gross height, and the background level is determined by a 
polynomial. 

  

Fig. 4-3 Models for the determination of the background level: fixed position (left) and fitting of a polynomial 
(right) 

The model that is used depends on the measurement method (MM file). 

The application (EVM file) 



 

 

 

 
Application icon 

The application is a set of parameters used for the evaluation of unknown samples. It is 
stored in an EVM file, created by APPLICATION SETUP, usually at the Evaluation 
model step of APPLICATION WIZARD. 

An application consists of: 

 a "collection" of files: 

 in case of a user-made calibration: a calibration file (FCL file), created with 
APPLICATION WIZARD; 

 in case of a precalibrated method: a measurement method (MM file), created 
with S2 MEASMETHOD 

 a format method (WZM file), created with the Result Manager (QUERY RES), 
usually at the Results formatting step of APPLICATION WIZARD; this defines the 
way the results are displayed and printed; 

 possibly a module file ( MLB file), i.e. calculations made from the concentrations, 
created with MODULES; 

 possibly a user batch (BAT file) or script (VBS, JS… file) for additional operation 
(e.g. writing the results in a user database); this batch or script is executed at the 
completion of an automatic evaluation (e.g. at the end of the measurement), or 
when saving the results in the Results database in EVAL2; 

 a list of parameters: 

 the preparation: this defines the additive (e.g. flux, wax, solvent…) that modify 
the matrix effects and dilute the sample, the absorption by the polymer foil for 
liquid or powder samples, the loss on ignition (LOI) for fused samples, the 
sample thickness and density to take the analyzed thickness into account… 

 fixed concentrations; 

 matrix compound, i.e. compound evaluated by balance to 100% from the other 
compounds instead of an evaluation with its XRF lines; 

 calculation options: neglecting low intensity lines or low concentration 
compounds, optimizing a sample characteristic (sum of all concentrations equal 
to 100%) by adjusting a sample parameter (dilution, thickness, a given 
concentration); 

 iteration parameters: maximum number of iterations, variation of 
concentrations between two iterations below which the result is considered as 
stable… 

 specification: conditions on concentrations a sample should meet (out of range 
concentrations can be highlighted on the display or printout). 

 

Preparation: foil, dilution and loss on ignition 
The preparation is the procedure that transforms the raw material into a measurable 
sample. There are four types of preparation: 

 solid (no preparation): the material is measured without any preparation; 

 pressed pellets: the material is a powder that is mixed with a binder (e.g. wax, 
cellulose…) and that is pressed to form the measurable sample; 



 

 

 

 liquid or powder: the material is a liquid or powder that is poured on a polymer film, or 
foil; if it is a liquid, it may be diluted; 

 fused bead: the material is dissolved in a flux to form a homogeneous glass sample. 

 

The preparation must be declared for five reasons: 

1. when a compound is added, it does not belong to the original material, so it must 
be subtracted from the results, but it must be taken into account for the matrix 
effects; 

2. the additive dilutes the original material, so the final result must be corrected to 
display the concentrations in the original material; 

3. the foil absorbs the X-rays, so the intensities must be corrected before the 
calculation, it is therefore necessary to know the type of material of the foil (.e.g. 
polypropylene, Mylar, Prolene…), its density and its thickness; 

4. when a sample is heated (fused bead), some material can be volatile or form a 
volatile oxide, this is the loss on ignition (LOI); the software corrects this effect 
and displays the concentrations in the original material (i.e. before fusion); 

5. when the sample is thin compared to the analyzed thickness, the intensity 
changes with the thickness; this thickness effect must be taken into account. 

When the raw material is mixed with an additive, the mass of raw material is Original-g, 
the mass of additive is Added-g, and the mass of the final sample is Finished Mass-g: 

 Original-g + Added-g = Finished Mass-g. 

When the dilution is expressed by the ratio a of additive (i.e. Added-g/Original-g), then the 
concentration Ci orig of the element i in the sample is linked with the concentration Ci prep in 
the prepared sample by the formula: 

 Ci orig = (1+a)·Ci prep 

and 

 1
1




i

prepiC
a  

the program first computes the Ci prep concentrations, then transforms them into the Ci orig 
for the display. 

  



 

 

 

When a sample is fused, there are two ways to compute the LOI: 

 by measuring the mass lost during the calcination of the raw material; the mass of raw 
material is Original-g, the mass of calcinated raw material is Ignited-g, and the LOI 
is: 
LOI = 1 - Ignited-g/Original-g 

 by comparing the mass of the sample before and after fusion; the mass before fusion 
is Non-fused Total-g (it is the sum of the raw material mass and of the flux mass), 
the mass of the measured sample is Finished Mass-g, and the LOI is 
LOI = 1 - (Finished Mass-g - Added-g)/Original-g 

 

Fig. 4-4 Two ways of calculating the loss on ignition 

When a0 is the nominal ratio of additive (i.e. Added-g/Original-g), then the real ratio of 
additive a (Added-g/Ignited-g) is linked to the LOI by 

 a = a0 /(1-LOI) 

By default, the concentrations displayed in the result are those in the original material, 
without any preparation (i.e. before addition, dilution, mixing or fusion). It is also possible 
to display the concentrations of the elements in the measured sample, these are the 
"prepared elements concentrations". 

 

Optimization: adjusting the sample parameters 
When samples parameters, such as the thickness, the sample diameter… are likely to 
vary, it is possible to let the calculation algorithm adjust them, provided the matrix 
correction is performed with the Variable Alphas method: these sample parameters are 
taken into account for the calculation of the concentrations. As the number of equations 
must always be equal or greater than the number of parameters, EVAL2 uses the fact that 
the sum of all concentrations must be equal to 100% . This adjustment is called 
"optimization". 

  



 

 

 

4.2. Performing the first evaluation 

Prerequisites 

To perform an interactive quantitative evaluation, it is necessary to have an application 
(EVM file) adapted to the evaluation that will be performed, i.e. using the right method 
(peak/background or spectrum), see the APPLICATION SETUP manual for more details. 
The other parameters (such as the calibration, the preparation, the fixed 
concentrations…) can be changed interactively. 

The first steps consist in: 

 creating an EVAL2 new document or opening an existing EVAL2 document (see the 
section 2.2.2 "Managing documents"); 

 importing a measurement (see the section 3 "Importing a sample"). 

 

Choosing the initial application 

Warning: When clicking Apply, this changes the parameters in the Results database, 
i.e. the evaluation parameters that were chosen become the default 
evaluation parameters. If the sample was evaluated before, EVAL2 works on 
a copy of it so the original record of the database is not modified. If the 
sample has never been evaluated, EVAL2 modifies the original record. 
If you do not want to change the records of the database, see the section 4.3 
"Adjusting the parameters". 

The default application (EVM file) is the same one used for the original measurement (as 
defined in the LOADER). EVAL2 knows which application was used because the system 
stores this information in the Results database (Measure.MDB). 

The application to be used can be changed at import of the sample in EVAL2: 

 

Fig. 4-5 Selection of the sample to be imported 

 
Evaluation 
options button 

1. In the Select Sample(s) for Evaluation dialog box, select the sample of interest; 

2. Click the Evaluation options button; 



 

 

 

 3. In the Advanced evaluation Option dialog box that appears, check the Force 
calibration box; 

4. Use the corresponding Browse button to retrieve the EVM file of interest; 

5. Click Apply. 

 

Fig. 4-6 Choosing another EVM file 

It is also possible to simply change the evaluation parameters, without changing EVM file 
referenced in the Results database. It is possible to: 

 
Browse button 

 use different calibration than the one defined in the default application: 

1. check the Force calibration box; 

2. click the Browse button; 

3. in the File of type drop-down list, select Calibration files for a user-made 
calibration (FCL file) or Measurement method files (MM file) for a standardless 
evaluation; 

4. browse to the file of interest, then click Open; 

 use a different preparation than the one defined in the default application: 

1. check the Force preparation box, 

2. select the new preparation in the drop-down list; 

 use different sample specific parameters 
these parameters are defined by the user at the measurement; these adjustable 
parameters depend on the method and can be the sample size, the loss on ignition… 

1. check the User field box; 

2. select the parameter in the drop-down list; 

3. type the value in the text box. 

 

  



 

 

 

Launching the first evaluation 

Once a sample is imported (see section 3 "Importing a sample") and the application is 
defined (see above), it is possible to start the evaluation. 

The first calculation is made in two steps: 

 
Initialize button 

 initialize the calculation, with the Initialize command of the Quanti 
menu, 
— or — 
with the Initialize button; 
the Status bar displays "Ready for calculation"; 

 

 
Compute 
concentrations 
button 

 launch the calculation with the Compute command of the Quanti 
menu 
— or — 
click the Compute concentrations button; 

 
Stop calculation 
button 

 if you want to interrupt the calculation (when it lasts a long time), 
press the Stop calculation button. As the calculation is not 
completed, it will not be possible to print or save it. 

The results are displayed in the Quant window (see section 2.3.1 "The Quant windows"). 

 

Fig. 4-7 Quant window with the results of the evaluation 

Note: The initialization and the first computation can be performed automatically at 
the import. For this: open the Quantitative Options dialog box (Tools | 
Options), and in the Calculation tab, check the two options. 

4.3. Adjusting the parameters 

Several parameters can be interactively set to adjust the evaluation. 

How to change the application 



 

 

 

Warning: When the EVAL2 document is saved, the parameters are modified in the 
Results database, i.e. the evaluation parameters that were chosen become 
the default evaluation parameters. If the sample was evaluated before, 
EVAL2 works on a copy of it; the original record of the database is thus not 
modified. If the sample has never been evaluated, EVAL2 modifies the 
original record. Do not save the EVAL2 document if you do not want to 
modify the Results database. 

To change an application: 

 
Toggle method 
bar button 

1. when the Evaluation Methods dialog box is not on screen: choose the Evaluation 
methods command of the View menu 
— or — 
click the Toggle method bar button;  

 
Browse button 

2. click the Browse button at the right of a file's text box to select a new file; 

 
Close button 

3. if you want to remove the Evaluation Methods dialog box from the display, click 
the Close button. 

 — or — 
click again on the Toggle method bar button. 

 

Fig. 4-8 The Evaluation Methods dialog box 

 

  



 

 

 

How to change the sample properties 

To display the Sample Properties dialog box: 

 
Toggle sample 
properties button 

 choose the Sample properties command in the View menu 
— or — 
click the Toggle sample properties button. 

It is then possible to: 

 change the preparation: 
select the new one in the Preparation drop-down list; 

 change the parameters of the current preparation (for this evaluation only, this does 
not change the preparation in the Materials database): 
choose the options and edit the text boxes. 

Parameter Description and options 

Analyzed layer  Infinite thickness assumed: the sample thickness is greater then 
the analyzed thickness for every line; 

 Area density: the sample does not have an infinite thickness for 
every lines; the "thin sample" effect is determined with the area 
density, i.e. the mass of the sample divided by the analyzed area 
(in g/cm

2
); 

 Diameter/Finished mass: the sample does not have an infinite 
thickness for every lines; the "thin sample" effect is determined 
with the diameter of the sample (in cm, assuming a cylinder) and 
its mass (in g). 

Additive formula chemical formula of the additive (see the section 4.1.3 Preparation: 
foil, dilution and loss on ignition). 

 Added element not in sample: when this box is checked, the 

elements contained in the additive are forced to 0 

Ratio dilution of the original material, expressed by the ratio between one 
of the following mass (see the section 4.1.3 Preparation: foil, dilution 
and loss on ignition): 

 Additive: mass of added material (Added-g); 

 Original: initial mass of sample, before preparation (Original-g); 

 Total: final mass of sample, i.e. Original + Additive (Finished 

Mass-g); 

Choose the ratio in the drop-down list and its value in the text box 
— or — 
type the initial mass of sample in the Original-g text box, ad the 
mass of additive in the Added-g text box. 

Loss on ignition for a Fused bead preparation only (see the section 4.1.3 
Preparation: foil, dilution and loss on ignition): 

 Ignited-g is the mass of original sample, after calcination; 

 Non-fused Total-g is the mass of uncalcinated sample+flux 

before the fusion; 

 Loss on ignition (% of original sample) is the LOI 

 



 

 

 

 

Fig. 4-9 Sample Properties dialog box: adjusting the sample parameters 

 

4.3.3 How to change the optimizations (automatic adjustment of sample parameters) 
The optimization options are in the Sample Properties box (see figure 4-9). To display this 
box: 

 
Toggle sample 
properties button 

 choose the Sample properties command in the View menu 
— or — 
click the Toggle sample properties button. 

The available options depend on the application: 

 when a matrix is defined (compound evaluated by balance to 100%), no other 
optimization is possible; 

 the Sample smaller than mask option is not available for liquid samples; 

 the Unknown dilution option is available only when an additive is defined; 

 the Unknown L.O.I. option is only available for fused beads. 

  



 

 

 

Option Description 

No (don't normalize) no normalization is performed, the sum of all concentrations can be 
different from 100% 

Matrix = 100%-others one of the compounds is evaluated by balance to 100% 

Unknown thickness when the sum of all concentrations exceeds 100%, the thickness is 
decreased; it is increased when the sum is below 100% 

Sample smaller than 
mask 

when the sum of all concentrations is below 100%, all the intensities 
are multiplied by a common factor 

Unknown dilution the amount of additive is adjusted so the sum of all concentrations (in 
the original material) is equal to 100% (this modifies the matrix 
effects) 

Unknown L.O.I. the LOI, and thus the real dilution, is adjusted so the sum of all 
concentrations (in the original material) is equal to 100%  

 

4.3.4 How to set a concentration 
It is possible to set a specific value to a concentration (e.g. when it is known by another 
analysis, or set to 0 when it is absent), or to define a specific way of calculation (e.g. 
choice of a given line or calculation by balance to 100%). 

This choice can be made by a right-click the line of the compound in the Quant window 
(context-sensitive menu). 

 

Fig. 4-10 Context-sensitive menu to set a concentration 

Option Description 

Set not present force the concentration to 0; it is displayed in red in the list 

Set matrix the compound is computed by balance to 100% from the sum of the 
other compounds; it is displayed in blue in the list 

Fix concentration the concentration is fixed to a value; it is displayed in red in the list 

Select line the concentration is evaluated using this line 

Chg formula change the chemical formula of the compound 

Delete removes the compound from the list; it does not appear even when 
the Show all elements option is selected 

Adjustable display parameters 

Choosing the columns of the Concentration table 
It is possible to define which data appear in the Concentration table. This does not 
influence the printout. 



 

 

 

To change the columns: 

 
Quant columns 
button 

 display the Select Quantitative Window Columns dialog box: select 
the Quant columns command in the View menu 
— or — 
click the Quant columns button; 

 
Add button 

 to add an element to the display: select this element in the left-side 
list, and then click the Add button; 

 
Remove button 

 to remove an element from the display: select this element from the 
right-side list, and then click the Remove button; 

 
Up and Down 
arrow buttons 

 the order of the columns can be changed: click an element of the 
right-side list, then click the Up or Down arrow button; 

  click OK to validate the changes, or on Cancel to discard them. 

 

Fig. 4-11 Select Quantitative Window Columns dialog box 

 



 

 

 

Launching the subsequent evaluations 

Once the parameters have been modified, repeat the whole evaluation process, i.e.: 

 
Initialize button 

 initialize the calculation, with the Initialize command of the Quanti menu, 
— or — 
with the Initialize button; 
the Status bar displays "Ready for calculation"; 

 

 
Compute 
concentrations 
button 

 launch the calculation with the Compute command of the Quanti menu 
— or — 
click the Compute concentrations button; 

 
Stop calculation 
button 

 if you want to interrupt the calculation (when it lasts e long time), press the Stop 
calculation button. As the calculation is not completed, it will not be possible to 
print or save it. 

Note: the calculation is launched directly after the initialization when the 
Automatically run evaluation after successful initialization option is 
checked (Qualitative Option dialog box, Calculation tab). 

 

  



 

 

 

4.4. Saving and printing the quantitative results 

If an error occurred during the computation, or if the computation was aborted, an error 
message is displayed in the Status bar and the Save results and Print commands are 
not available (the buttons are grayed). 

Otherwise, once the result is calculated, the concentrations appear in black and the 
Status bar shows "ready". 

 

Fig. 4-12 Status bar 

Saving the results to the Results database 
It is possible to save the result in the Results database (Measure.MDB); it can then be 
retrieved with the RESULTS MONITOR. For this: 

 
Save results 
button 

 choose the Save results command of the Quanti menu 
— or — 
click the Save results button. 

When a batch (BAT file) or a script (VBS, JS… file) is defined in the application (EVM file), 
this batch or script is executed when saving the results in the database. 

Copying the results to the clipboard 
The results can be copied to the clipboard, as a table, and be pasted into another 
Windows

®
-based application (e.g. a spreadsheet). 

To copy the results to the clipboard: 

 
Copy button 

 choose the Copy to clipboard command in the Tool menu 
— or — 
click the Copy button 

 

  



 

 

 

Defining the printing style 
The units and the number of decimal ciphers are defined by a WZM file. The other 
parameters of the WZM file (such as the character font and color) are not taken into 
account by EVAL2. To use all the features of the WZM, it is possible to print from the 
RESULTS MONITOR after the export of the results in the database (see above). 

To declare a WZM file to the document: 

 
Toggle method 
bar button 

 when the Evaluation Methods dialog box is not on screen: choose the Evaluation 
methods command of the View menu 
— or — 
click the Toggle method bar button; 

 
Browse button 

 click the Browse button at the right of the Format Method text box to select a 
new WZM file; 
— or — 
to use the default formatting, clear the Format Method text box; 

 
Close button 

 if you want to remove the Evaluation Methods dialog box from the display, click 
the Close button, 

  — or — 
click again on the Evaluation Methods button. 

 

The general parameters, such as the page size and the layout (portrait or landscape) are 
defined in the Print Setup dialog box: 

 choose the Print Setup command in the File menu. 

 

Printing the results 
To display a preview of the printout: 

 choose the Print Preview command in the File menu. 

 

To print the result: 

 
Print button 

 choose the Print command in the File menu 
— or — 
press the CTRL+P key combination 
— or — 
click the Print button. 

The menu command and the key combination display the Print dialog box, where it is 
possible to choose the printer. The Print button directly starts the printing. 

 

  



 

 

 

5. Graphical display and qualitative evaluation 
The aim of the qualitative evaluation is to give the list of the detected elements (i.e. peaks 
above the detection limit), without any quantitative information (the concentration is not 
calculated). 

The qualitative evaluation is performed in a Quali window (see section 2.3.2). 

 

Fig. 5-1 Qualitative evaluation in a Quali window 

 



 

 

 

5.1. Items of a Quali window 

A Quali window is a composite document that can contain three types of objects: Ranges, 
Elements and Labels. As these words also have a general meaning, they are written with 
an upper case capital letter when they refer to the EVAL2 items. 

 

Ranges 

In a single run, a sample can be measured with different sets of parameters (tube high 
voltage, tube filter, detector parameters); in this case all the measurements are stored in a 
single SSD file. 

When a single SSD file contains several measurements, each measurement is called a 
"Range". In the Quali window, each range is displayed as a separate curve. 

To know more about Ranges, see: 

 the section 5.5.3 "Color of a Range" 

 

Elements 

An Element is the set of spectral lines that are emitted by the chemical element. The 
spectral lines of the Element are displayed as sticks on the graphic. 

The positions of the sticks correspond to the energy of the lines. The heights of the sticks 
are automatically adjusted to the graphical display of the Ranges. The height of the sticks 
can then be adjusted manually, but the relative height remains the same for the sticks of 
the same Element. 

To know more about Elements, see: 

 the section 5.4 "Qualitative evaluation" 

 the section 5.5.5 "Display parameters of the spectral lines (Elements) " 

 

Labels 

A label is a text box that that is linked to a specific point of the graphic through a stroke. It 
can be used to point out a specific part of the graphic, and especially the spectral lines. It 
is just a graphical item for the convenience of the user. 

To know more about Labels, see: 

 the section 5.5.6 "Creation and handling of Labels" 



 

 

 

5.2. Creation of a Quali window and import of a spectrum 

The graphical window, or Quali window, is the window where the spectra are displayed. A 
graphical window can be created in two ways: 

 in the Window menu, choose New Quali window; 
— or — 

 
Alternative Mode 
Window button 

 in a Quant window, click the Alternative Mode Window button. 

When SSD files were already imported, the graphical window displays the related spectra. 
When the EVAL2 document was empty, the graphical window is also empty; the curves 
appear automatically when the SSD files are imported (see section 3 "Importing a 
sample"). There is one curve for each range, i.e. several curves can be displayed for a 
single file. 

  



 

 

 

5.3. Graphical display after a quantitative evaluation 

The Quali window can be used to display the spectra and the positions of the lines after a 
quantitative evaluation. 

The Quali window automatically displays the spectra (ranges) of the SSD file used for the 
quantitative evaluation (i.e. processed in the Quant window). To add the sticks 
representing the line (Element): 

 in the Quali menu, choose the Show lines command. 

This command is only available after the quantitative evaluation. 

To change the layout of the graphic, see section 5.5 "Display tools and options". 

  



 

 

 

5.4. Qualitative evaluation 

Automatic evaluation 

To perform an automatic evaluation: 

 select the Evaluation command in the Quali menu. 

This is usually the first operation done after the import of the spectrum. 

The qualitative evaluation algorithm performs a peak search on the spectra, using the 
curvature of the curves: a peak corresponds to a minimum of the second derivative. For 
this, the curves are smoothed with a Savitzky-Golay algorithm. 

 

Fig. 5-2 Peak search algorithm using the Savitzky-Golay smoothing and the second derivative 

An element is considered as present when the net height Nnet of his peak (in cumulated 
counts) is above the level of the noise, determined by the level of the background Nbkg and 
the Poisson's law: 

bkgbkgnet NkNN   

where k is a statistical coefficient related to the confidence level, usually set to 3. When 
more than one line is available for a single element, the algorithm considers several lines 
to avoid a "false detection" due to an overlap. 

 

Parameters of the qualitative evaluation algorithm 

Some parameters of the qualitative evaluation algorithm can be changed. They are in the 
Auto Quali and Quali filter tabs of the Qualitative Options dialog box. 

To display the Qualitative Options dialog box: 

 in the Tools menu, select the Options command. 

 



 

 

 

Auto Quali tab 
The peak search and peak filtering parameters are in the Auto Quali tab: 

 Peak search noise threshold: the k statistical parameter in the Poisson's law; the 

higher the value, the more restrictive the filter (low concentration elements may not be 
detected); 

 Peak search energy window: width of the sliding segment in the Savitzky-Golay 
algorithm; 

 WDX: 2-Theta search window: when a peak is detected, it is attributed to the 
nearest element that is inside this search window (this is necessary due to possible 
shifts); the factor in this text box is multiplied by the collimator aperture; 

 Concentration limits for view line: the lines of the elements which concentration is 
below this level are not displayed. 

 

Fig. 5-3 Auto Quali tab of the Qualitative Options dialog box 

 

Quali filter tab 
This tab represents a periodic table of the elements. When an element is displayed in 
gray, it is never included in an automatic qualitative evaluation; when it is displayed in 
green, it is checked by the qualitative evaluation algorithm. 

To activate or de-activate an element: 

 Click the element box of interest 
— or — 
right-click the element and in the context-sensitive menu that appears, choose Select 
or No check. 

  



 

 

 

 

Fig. 5-4 Quali filter tab of the Qualitative options dialog box 

 

Manual adjustment 

To add or remove the sticks corresponding to an element: 

 
Elements toolbar 
button 

 if necessary, display the XRF Lines window: click the Elements toolbar button 
or 
select the Elements toolbar command in the View menu; 

 Click the box of the element to display or hide. 

The XRF Lines window represents a periodic table of the elements. When an element is 
displayed, its box is in light gray and its indicator is red. When an element is hidden, its 
box is in dark gray and the indicator is black. 

 

Fig. 5-5 The iron lines are displayed and the cobalt ones are hidden 

For more information on the XRF Lines window, see the section 2.3.3 "Organizing the 
windows". 

 

Selection of a range or an element 
Some tools only apply on one range (curve) or element (sticks). The selection determines 
the object that is affected by those tools. It is performed using the context-sensitive menu: 

5. right-click the object of interest; 

6. in the menu that appears, choose the Select option. 

 



 

 

 

Identifying an element or a curve with the pop-up information  
When the mouse cursor is let still on an object (a Range or a stick of an Element), a pop-
up label (or tooltip) displays the name of the object. 

 

Fig. 5-6 Pop-up information window for the identification of a line 

The information displayed in the pop-up window can be set up for the Ranges. The 
settings are defined in the Scan display tab of the Qualitative Options dialog box: 

 in the Tools menu, choose the Options… command. 

 

Option Description 

Show calculated 
background 

In case of a scan measurement, it is possible to determine the 
background using the whole scan and not fixed positions; this option 
shows the background that is calculated in this case. 

Show measurement 
parameters in tooltips 

The measurement parameters for the range (i.e. tube high voltage 
and filter) are displayed along with the file name and the name of the 
measured lines. 

Show integral rate in 
tooltips 

The count rate I. Rate for the whole spectrum (i.e. the number of 

counts per second without consideration of the height of the count) is 
displayed 

Hide non selected 
files by default 

When several files are imported to EVAL2, the “selected file” is the file 
to which the selected range belongs. With this option checked, the 
non files are not displayed. 

Auto select the active 
quantitative sample 

When several files are imported to EVAL2, only one of them can be 
used for the quantitative evaluation. When this option checked, the 
selected file is automatically the sample that appears in the Quant 
window. 

Intensity scale option Select the unit of the Y-scale. The scale itself (linear or square root) is 
set by the context-sensitive menu (right-click the Y axis, see section 
5.5.2 “X- and Y-scale setup”). 

 



 

 

 

Fig. 5-7 Scan display tab of the Qualitative Options dialog box  

 

  



 

 

 

5.5. Display tools and options 

Zooming 

The zoom can be performed in two ways: 

 stretch a box around the area to be magnified: click the top left corner of the area of 
interest, and move the mouse pointer to the bottom right corner while holding the 
click; then release the click; during this operation, the mouse pointer looks like a 
magnifying glass; 
— or — 
right-click anywhere in the graphical window, and choose Zoom+ in the context-
sensitive menu that appears; the zoom is performed around the position of the click. 

 

Fig. 5-8 Zooming the curves in a Quali window 

  



 

 

 

There are three ways to zoom back (or unzoom): 

 to double-click anywhere on the graphic; 

 right-click anywhere in the graphic, and in the context-sensitive menu, choose Zoom - 
or Zoom reset; 

 right-click the Y-axis and select Reset y zoom: this keeps the X range but displays 
the full data of this X range. 

 

Fig. 5-9 Zooming with the context-sensitive menu 

If the mouse has a wheel third button, it is also possible to use the wheel to zoom in and 
out. 

 

X- and Y-scale setup 

X-scale 
The X-scale can be: 

 proportional to the square root of the energy: according the Moseley's law, the lines of 

a given type (e.g. the K lines) are spaced evenly with this scale; in this case, the X-
scale can be graduated in keV (energy of the photons) or in Å (wavelength of the 
radiation); 

 proportional to the energy; in this case, the scale is graduated in keV. 

It can also be: 

 in increasing order of the energy: this is the "natural" order of an axis; 

 in decreasing order of the energy: the lines are in the same order as the 2 order in a 
wavelength dispersive spectrometer. 

  



 

 

 

The X-scale is chosen with a right-click the X-axis; the options of the context-sensitive 
menu are: 

 Kev <-: scale in square root of energy, in decreasing order, graduated in energy 
(keV); this is the default mode; 

 KeV ->: scale in square root of energy, in decreasing order, graduated in energy 
(keV); 

 LKeV <-: scale linear in energy, in decreasing order; 

 LKev ->: scale linear in energy, in increasing order; 

 Ao: scale similar to Kev <-, but the graduations are the wavelength of the radiations 
in Angström (Å); 

 ° 2Theta crystal (where crystal can be LiF200, PET…): scale linear in degrees; only 
the ranges measured on the same crystal are displayed 

 

Y-scale 
The Y-scale can be set with a right-click the Y-axis (context-sensitive menu): 

 proportional to the count rate: select Lin in the context-sensitive menu; 

 proportional to the square root of the count rate: select Sqrt in the context-sensitive 
menu. 

 

Color of a Range 

The colors of the Ranges (spectra) follow the rules set in the Color scheme tab of the 
Qualitative Options dialog box. To open this dialog box: 

 click the Options… command of the Tools menu. 

When several SSD files are imported, it is usually not possible to have individual colors for 
each Range (curve); a color is used to highlight the Ranges that have something in 
common, and thus point out the similarities and discrepancies between them. The options 
are: 

 Same color except selected range: this highlights a single Range; 

 Same color for all except selected file: this highlights the Ranges belonging to the 
same SSD file; 

 Same color for same parameters: when only one SSD file is imported, this option 
allows a different color for each Range ; when several SSD files are imported, this 
allows to compare what can be compared; 

 Same color for same file order: the color depends on the order of the Range in the 
SSD file. 



 

 

 

 

Fig. 5-10 Color scheme tab of the Qualitative Options dialog box 

To select a Range: 

 right-click the related curve, and in the context-sensitive menu, choose Selection. 

When the Same color except selected range or the Same color for all except 
selected file option was set, this operation changes the colors of the curves. 

To set the colors: 

 right-click the related curve, and in the context-sensitive menu, choose Color; 

 in the Color dialog box that appears, select the color and click OK. 

 

Display of the background line 

The background line is automatically displayed when the Show calculated background 
option is checked in the Scan display tab of the Qualitative Options dialog box (see figure 
5-7). 

To display the Qualitative Options dialog box: 

 in the Tools menu, choose the Options… command. 

The option must be checked before the import of the SSD file. The background line is 
computed with the same algorithm as the one used for the Lower Envelope method (see 
the subsection "Evaluation with the peak/background method" of the section 4.1.2). 

The background line is always displayed in blue. A right-click the background line is 
considered as a right-click the related Range. 

  



 

 

 

 

Display parameters of the spectral lines (Elements) 

Height of the sticks 
To adjust the height of the sticks: 

 place the mouse pointer at the top of a stick; the shape of the pointer changes to a 
hand pointing the forefinger; 

 press the mouse button and hold the click while moving the pointer up or down; 

 release the button when the aimed height is reached. 

This adjusts the height of all the sticks figuring the lines of the same element together. 

 

Fig. 5-11 Adjusting the height of the sticks figuring the lines for an element 

 

Color of the sticks 
The colors of the sticks figuring the spectral lines follow the rules set in the Color scheme 
tab of the Qualitative Options dialog box (see figure 5-10). To open this dialog box: 

 Click the Options… command of the Tools menu. 

The options are: 

 Same color for same atomic number: all the sticks of a given Element have the 
same color; 

 Same color for same order of selection: the color of each stick is defined 
independently; the colors are stored (in the Windows® registry), so for the next 
samples to be processed, the color of a stick can be set just by selecting it, following 
the same color pattern. 

To change the color of an element (first option) or of a stick (second option): 

 right-click one of the lines; 

 in the context-sensitive menu, select Color; 

 in the Color dialog box, select the color and click OK. 

 



 

 

 

Removing the sticks of an element 
To remove the sticks representing the lines of an element: 

7. right-click one of the sticks; 

8. in the context-sensitive menu, select Delete element. 

where element is the chemical symbol of the element. 

It is also possible to remove all the sticks on the display: 

 in the Quali menu, choose the Delete all elements command. 

 

Creation and handling of Labels 

A label is a text box that that is linked to a specific point of the graphic through a line (see 
section 5.1.3 "Labels"). 

To add a label: 

 right-click anywhere in the graphic (except on a curve or on an element stick) 

 in the context-sensitive menu, choose Label. 

 in the Insert Label dialog box that appears, type in the text of the label; 

 choose the orientation of the text box: Horizontal, 45 Degrees or 90 Degrees; 

 click OK. 

 

 

 

Fig. 5-12 Labels on the graphic 

  



 

 

 

Once a label is created, you can: 

 move the attachment point: click the attachment point, and move the cursor while 
clicking; the whole label (text box, line and attachment point) moves; 

 move the text box, the attachment point remaining the same: click the text box and 
move the cursor while clicking; 

 change the text or the orientation of the text box: right-click the label, and in the 
context-sensitive menu, choose Edit; 

 remove the label: right-click the label, and in the context-sensitive menu, choose 
Delete; 

  

Fig. 5-13 Moving the attachment point (left) or just the text box (right) 

 

Automatic creation of labels 
To label the sticks corresponding to an element: 

 right-click one of the sticks,  

 in the context-sensitive menu that appears, choose Label this element. 

This writes the name of the spectral lines on the top of the sticks. 

 

Fig. 5-14 Labels on the top of the Elements 

To label a range: 

 right-click the range of interest; 

 in the context-sensitive menu that appears, choose Label this range. 

 

Fig. 5-15 Labeling the Ranges 

 



 

 

 

5.6. Saving and printing the qualitative results 

Copying the graphic to the clipboard 
The graphic can be copied to the clipboard, as a picture, and be pasted into another 
Windows

®
-based application. 

To copy the results to the clipboard: 

 
Copy to clipboard 
button 

 choose the Copy to clipboard command in the Tool menu 
— or — 
click the Copy to clipboard button 

 

Printing the results 
The results can be printed, provided a printer is installed. 

To display a preview of the printout: 

 choose the Print Preview command in the File menu. 

The general parameters, such as the page size and the layout (portrait or landscape) are 
defined in the Print Setup dialog box: 

 choose the Print Setup command in the File menu. 

To print the result: 

 
Print button 

 choose the Print command in the File menu 
— or — 
press the CTRL+P key combination 
— or — 
click the Print button. 

The menu command and the key combination display the Print dialog box, where it is 
possible to choose the printer. The Print button directly starts the printing. 
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6. Glossary 

Analyzed thickness 
The analyzed thickness describes the sample layer from which 90% of the intensity is 
generated. It is the thickness that corresponds to the depth from which the specific 
radiation can emerge and can be calculated depending on the matrix.When the sample is 
thinner than the analyzed thickness, the intensity of the line depends on the thickness of 
the sample. When the sample is thicker than the analyzed thickness, the intensity does 
not depend on the sample thickness; the sample has an "infinite thickness". 

Compound 
A chemical compound is a set of atoms linked by chemical bonds. In SPECTRA EDX, the 
compounds are used to determine the concentrations in light elements. 

Light elements are difficult or impossible to measure in XRF (their fluorescence yield is 
poor, and their lines have a low energy and are easily absorbed). Thus, the line of the 
heaviest element (or key element) is measured, and the other elements of the compound 
are determined by stoechiometry. Typical compounds are oxides (e.g. CaO, Na2O, 
Fe2O3…) and single elements (mono-element compound, e.g. Ca, Na, Fe…). 

Compton ratio  
The purpose of X-ray fluorescence spectrometry is the qualitative and quantitative 
determination of the elements in a sample by measuring their characteristic radiation. As 
the sample is exposed to a beam of X-ray quanta from a tube, a proportion of these X-
rays also reach the detector in the form of radiation background as a result of physical 
scattering processes. While the scattered Bremsstrahlung proportion generally produces 
a continuous background, the scattered characteristic radiation of the anode material 
contributes towards the line spectrum. Besides the lines of elements from the sample, the 
anode material's lines and the scattered Bremsspektrum usually appear as well as a 
background. 

The intensity of the scattering depends on the composition of the sample: for samples 
that are mainly composed of light elements (light matrix), the proportion of scattered 
radiation is high. In samples composed mainly of heavy elements (heavy matrix), the 
scattered proportion is relatively low. 

Background and characteristic scattering can be very effectively reduced by inserting a 
suitable absorption material between tube and sample. 

The Rh quanta coming from the tube strike the sample elements' electrons. In this 
process, some of a quantum's energy is transferred to an electron. The X-ray quantum 
therefore loses energy. The intensity of the quanta scattered by the Compton effect 
depends, among other factors, on the tube radiation's angle of incidence to the sample 
and on the take-off angle of the radiation in the spectrometer. As these angle settings are 
fixed in a spectrometer, a somewhat wider peak appears on the low-energy side of the 
appropriate Rh peak. These peaks are called "Compton peaks." 

In EVAL2, the Compton factor is defined as the calculated Compton divided by the 
measured factor; when the calculated concentrations are close to the real ones, the ratio 
is close to 1. If you get a Compton factor higher than 1, it means the matrix is too light 
and you can add oxygen or take away a light matrix. 
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If you do not know if your samples are oxides or elements you should use the Compton 
factor to optimize the matrix. 

The Compton factor can be applied from a light to a moderate light matrix. 

For heavier matrices you can use the Rayleigh factor (see further Rayleigh ratio). 

Key element 
In a compound, the key element is the element used for the evaluation. The other 
elements of the compound are determined by stoechiometry. 

Lower limit of detection 
The lower limit of detection, or LLD, is the minimum detectable concentration of an 
element or compound in a matrix. It is given by the following expression: 

t

I

m
LLD

Bkg


3
 

in which 

 m is the sensitivity; 

 IBkg is the intensity of the background at the defined wavelength; 

 t the counting time on the background. 

A peak can be detected only when its net height is above the fluctuations of the signal, 
which can be determined by applying the Poisson's law on the background level; this net 
height is then converted into a concentration, with the calibration coefficient and the 
matrix corrections. 

A LLD is always specific for an element in a given matrix and should be presented 
together with the counting time. The detection limit for the same element can vary 
because of the difference in matrix. For example, the detection limit for S in Oil is different 
from S in a metal sample. 

Matrix 
In general, the matrix is the part of the samples composed of the major 
compounds/elements. In most of the cases, the matrix is not measured, for example CH2 
in oils. 

In SPECTRA EDX, a matrix is a compound whose concentration is evaluated from the 
other concentrations by balance to 100%. It appears in blue in the Concentration list. It is 
typically used to estimate the concentration of a compound that has no measurable 
element (e.g. oil, polymer, water), or when the concentration itself has no interest (e.g. 
iron in steel). 

Moseley's law 
The Moseley's law is an empirical law discovered by Henry Moseley in 1912: the square 
root of the frequency of the radiation follows an affin law in Z (atomic number): 

 )(   ZC  

where C and  are constants for a given type of line (e.g. all the K have the same 

constants, all the K lines have their own…). Therefore, the energy of the photon follows 
a similar law (this conclusion comes with the definition of the Planck's constant h): 
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 )(  ZhCE  

thus, on a scale in square root of the energy, the lines of a given type are spaced evenly. 

Planck's constant 

The Planck's constant h links the energy E of the photons and the frequency  of the 

radiation, or its wavelength : 

 E = h· h·c/

in which c is the speed of light in vacuum (2.997 924 58·10
8
 m/s). 

 h ≈ 6.626 1·10
-34

 J·s 

When the wavelength is in Å and the energy is in keV, the formula becomes 

 E ≈ 12.4/ 

Poisson's law 
The Poisson's law is a statistical law followed by the XRF signal. When N counts are 

cumulated during a period t, then the standard deviation N can be estimated by the 
square root of the number of counts 

 NN   

and the standard deviation I on the intensity I = N/t (count rate) is 

 
t

I

t

N

t

N

I 


  

This allows the calculation of the statistical error and of the lower limit of detection: the 
statistical error is taken as 

NkN   ; IkI   

where k is a constant related to the confidence level, usually taken as 3. 

Rayleigh ratio  
While some incident X photons are captured by the photoelectric effect (giving the 
fluorescence), some other are scattered by Rayleigh effect by the atoms of the sample. 
When the characteristic lines of the X-ray tube are not filtered, they give Rayleigh lines, 
i.e. lines with the same energy as the incident ones. 

The height of the Rayleigh lines can be computed from the sample composition; the ratio 
between the height of the measured Rayleigh lines and the calculated Rayleigh line is 
called the Rayleigh ratio; when the calculated concentrations are close to the real ones, 
the ratio is close to 1. 

The Rayleigh ratio can be used to optimized sample parameters (e.g. thickness, density, 
dilution…) of heavy matrix samples (the Rayleigh diffusion is more important on heavy 
elements), but only on amorphous, or best liquid sample (due to diffraction phenomena). 
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Statistical error 
The statistical error is the error due to the fluctuation of the XRF signal. It can be 
evaluated with the Poisson's law (the statistical error is three times the standard 
deviation). It is a part of the error on the concentration, which also includes the error of 
preparation and the error of the calibration. 
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Appendix A Appendix 

A Menus 

Window Management menu 

Window Management menu 

Command Other 
access 

Effect 

Restore 

 

when the window is maximized or minimized, use this 
command to be able to adjust yourself the size of the window 

Move  when this command is activated, the only possible action 
with the mouse is to move the window; this can be useful 
when, after having changed the resolution of the screen, the 
window spreads out of the screen and you are unable to 
reach the borders to resize it 

Size  when this command is activated, the only possible action 
with the mouse is to resize the window 

Minimize 

 

for an Evaluation window: the window is reduced to a small 
toolbar, with only the name of the window and three buttons 

 

for the EVAL2 window, the window disappears, only the 
button in the Taskbar remains 

 

Maximize 

 

for an Evaluation window, it adjusts its size so it fits exactly 
the EVAL2 window; 

for the EVAL2 window, it adjusts its size so it fits the whole 
screen 

in both cases, the size cannot be changed 

Close (Quali or 
Quant window) 

CTRL+F4 

 

close the current Quant or Quali window 

Close (EVAL2) ALT+F4 

 

quit the program 

Next CTRL+F6 go to another Quali or Quant window  
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File menu 
File menu 

Command Other 
access 

Effect 

New CTRL+N create a new Quant window 

Close CTRL+F4 

 

close the current Quant or Quali window 

Import raw data 

 

open the Select Sample(s) for Evaluation dialog box; the 
selected SSD file is then imported in the document 

when the EVAL2 document already has an SSD file, then the 
new SSD file is added to the document; evaluation is no 
longer possible, but spectra can be compared 

Next document 

 

Remove the current SSD file and open the Select Sample(s) 
for Evaluation dialog box; the selected SSD file is then 
imported in the document 

Print CTRL+P 

 

Quant window: print the concentrations; see section 4.4 
"Saving and printing the quantitative results" 

Quali window: print the graphic; see section 5.6 "Saving and 
printing the qualitative results" 

Print preview  display a preview of what will be printed 

Print setup  open the Print Setup dialog box: choice of the printer, of the 
paper orientation… 

Exit ALT+F4 

 

quit the program 
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View menu 
View menu 

Command Other 
access 

Effect 

Toolbar  display or hide the Toolbar with the shortcut buttons 

Status bar  display or hide the Status bar, at the bottom of the EVAL2 
window 

n
th

 Quant window 

— or — 
n

th
 Quali window 

 switch to the corresponding window 

All elements 

 

Display the elements that were found absent 

Commands specific to the Quant windows 

Evaluation 
methods 

 

display or hide the Evaluation Methods dialog box 

Sample 
properties 

 

display or hide the Sample Properties dialog box 

Quant columns 

 

display the Select Quantitative Window Columns dialog box 

Commands specific to the Quali windows 

Elements toolbar 

 

display or hide the Elements toolbar (periodic table of the 
elements) 

 

Quanti menu 
This menu is available only for the Quant windows. 

Quanti menu 

Command Other 
access 

Effect 

Initialize 

 

set the concentration to their default values in order to start 
the calculation 

see section 4.2.3 "Launching the first evaluation" 

Compute 

 

start the calculation of the concentrations 

see section 4.2.3 "Launching the first evaluation" 

Save results 

 

store the results in the Results database (Measure.MDB) 

see section 4.4 "Saving and printing the quantitative results" 
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Stop calculation 

 

stop the calculation that is running 

Add compound  display the Insert Compound dialog box 
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Quali menu 
This menu is available only for the Quali windows. 

Quali menu 

Command Other 
access 

Effect 

Evaluation  launch the qualitative evaluation, and display the elements 
sticks 

Show lines  display the sticks representing the lines of the elements 
found in a quantitative evaluation;; 

only the elements which concentration is above a given 
threshold are displayed; this threshold is set at the Auto 
Quali tab of the Qualitative Options dialog box 

Label lines  place a Label on the top of each line 

Rearrange labels  move the labels according to the current zoom 

Delete all 
elements 

 remove all the sticks figuring the elements from the display 

Hide inactive files 

 

when a curve is selected (right-click the curve, option 
Select), only the curves of the same SSD file are displayed 

Display all files 

 

display all curves, for the SSD files imported into the 
document 

 

Advanced menu 
Advanced menu 

Command Effect 

Specific to Quant windows 

Standard Material Import a standard material and display its concentrations 

Evaluate by GUID Simulate the automatic evaluation by QUANTEVL2; type in the general 
unique identifier (e.g. read with DUMPSSD) to perform this evaluation 

Specific to Quali Windows 

Sample 
absorption 

Plot the sample absorption (calculated form the composition) in arbitrary Y-
scale 

Tube output Plot the tube spectrum (theoretical model) 
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Window menu 
Window menu 

Command Effect 

New Quali window create a new Quali window 

New Quant Window create a new Quant window 

Tile horizontally all the windows are displayed, one above the other, without overlap 

Tile vertically all windows are displayed, besides each others, without overlap 

 

Tools menu 
Tools menu 

Command Effect 

Options… display the Quantitative Options or the Qualitative Options dialog box, 
according to the type of the current window 

Copy to clipboard copy the content of the current window, so it can be pasted into another 
document (e.g. text processor, spreadsheet or presentation) 

see section 4.4 "Saving and printing the quantitative results" and 5.6 
"Saving and printing the qualitative results" 

 

Help menu 
Help menu 

Command Other 
access 

Effect 

About Eval2… 

 

display the About Eval2 dialog box, with the version number 
of the software 
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Appendix B Toolbar 

 

File zone 

Command Other 
access 

Effect 

 

File | Next 
document 

Remove the current SSD file and open the Select Sample(s) 
for Evaluation dialog box; the selected SSD file is then 
imported in the document 

 

File | Import 
raw data 

open the Select Sample(s) for Evaluation dialog box; the 
selected SSD file is then imported in the document 

when the EVAL2 document already has an SSD file, then the 
new SSD file is added to the document; evaluation is no 
longer possible, but spectra can be compared 
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Evaluation zone 

Buttons common to both windows 

 

View | All 
elements 

display the elements that are absent 

Buttons specific to Quant windows 

 

Quanti | 
Initialize 

set the concentration to their default values in order to start 
the calculation 

see section 4.2.3 "Launching the first evaluation" 

 

Quanti | 
Compute 

start the calculation of the concentrations 

see section 4.2.3 "Launching the first evaluation" 

 

 normalize: apply the Sample smaller than mask option 

(Sample Properties box, see section 4.3.3) 

 

Quanti | 
Save results 

store the results in the Results database (Measure.MDB) 

see section 4.4 "Saving and printing the quantitative results"  

 

Quanti | Stop 
calculation 

stop the calculation that is running 

 

 display the concentration in compounds or in elements 

 

 display the original concentration (i.e. in the material before 
the preparation) or the prepared concentration (i.e. in the 
sample that is measured, after preparation) 

 

View | Quant 
columns 

display the Select Quantitative Window Columns dialog box 

 

View | 
Evaluation 
methods 

display or hide the Evaluation Methods dialog box 

 

View | 
Sample 
properties 

display or hide the Sample Properties dialog box 

 

View/Quali zone 

 

View | 
Elements 
toolbar 

display or hide the Elements toolbar (periodic table of the 
elements) 

 

Quali | Hide 
inactive files 

Quali | 
Display all 
files 

when a curve is selected (right-click the curve, Select 

option), this buttons allows to display or hide the curves that 
do not belong to the same SSD file as the active curve 
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Window zone 

 Alternative mode window: 

 

in a Quant window, press the button to switch to the corresponding Quali 
window or to create it when it does not exist; 

 

 

in a Quali window, press the button to switch to the corresponding Quant 
window or to create it when it does not exist 

 

Tools zone 

 

Tools | Copy 
to clipboard 

copy the content of the current window, so it can be pasted 
into another document (e.g. text processor, spreadsheet or 
presentation) 

see section 4.4 "Saving and printing the quantitative results" 
and 5.6 "Saving and printing the qualitative results" 

 

Print zone 

 

 Quant window: print the concentrations (fast print)1; see 
section 4.4 "Saving and printing the quantitative results" and 
5.6 "Saving and printing the qualitative results" 

Quali window: print the graphic (fast print); see section 5.6 
"Saving and printing the qualitative results" 

 

Help zone 

 

Help | About 
Eval2… 

display the About Eval2 dialog box, with the version number 
of the software 

 

  

                                                           
1 the printing is launched without opening the Print dialog box; it is thus different from and the File | Print menu command or the 

CTRL+P key combination 
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Appendix C Windows and dialog boxes 

C.1 Importing a sample 

SPECTRA EDX Login dialog box 
This dialog box appears when the logon limit time is reached (see section 1.3 "Starting 
EVAL2"). This time is set in the SYSTEM CONFIGURATION. Most programs of the 
SPECTRA EDX package require to be logged. 

 

To log on: 

 Fill in the User name and the Password text fields; 

 Click OK. 

See also the section 1.3 "Starting EVAL2". 

 

Select Sample(s) for Evaluation dialog box 
This dialog box is used to choose the data that will be processed. It appears: 

  when clicking the Evaluation button of the SPECTRA EDX Launcher 
— or — 

  
Import raw 
data/Next 
document buttons 

 when importing a sample from EVAL2, with the Import raw data/Next document 
button or the related commands of the File menu. 
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Control Description 

Search database search in the Measure.MDB database and display the samples that 
correspond to the default criteria, or to the Advanced Search criteria is 
the related window is opened 

Advanced search open the Advanced Search dialog box, to define specific search 
criteria 

Default search open the Default Search Options dialog box 

Evaluation option display the Advanced Evaluation Options dialog box, to supersede the 
application 

Controls available only from EVAL2 

OK import the selected sample(s) 

Cancel go back to the main window without importing 

Controls available only from SPECTRA EDX Launcher 

Interactive Quant. open EVAL2 and import the sample into a Quant window 

Interactive Quali. open EVAL2 and import the sample into a Quali window 

Batch Quantification launch a batch quantification 

 

See also the chapter 3 "Importing a sample" 

 

Default Search Options dialog box 

Default search 
button 

This dialog box appears when clicking the Default search button in the Select Sample(s) 
for Evaluation dialog box. Here are defined the default criteria to select the samples in the 
Measure.MDB database. 
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Control Description 

Search the database 
when the window is 
popped (check box) 

when this option is checked, the search is automatically performed 
when the window is displayed, i.e. when clicking the Import data file 
button (EVAL2) or on the Evaluation button (SPECTRA EDX 
Launcher) 

Sample list columns 
(button) 

display the Select Samples List Columns dialog box, where it is 
possible to choose the columns of the table 

Operators (radio 
buttons) 

Current: only the samples measured by the operator that is logged; 

Any: no filter 

Date and number 
options (radio buttons 

Measured today: only the samples measured today 

Current week: only the samples measured this week 

Past n days: only the samples measured during the last n days 

Past n samples: last n measured samples 

No date and number limitation: no filter 

Evaluation status Not yet evaluated (radio buttons): only display the samples that are 

not evaluated 

All samples (radio buttons): also display the samples that are already 
evaluated 

All occurrences of the same sample:  

Methods (radio 
buttons) 

Any:  no filter 

Selected: only the samples that were measured with the selected 
methods 

Not selected: only the samples that were not measured with the 
selected methods 

the two last options activate the list of measurement methods 

OK (button) Validate the parameters and close the window 

Cancel (button) discard the changes and close the window 
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Advanced Search dialog box 

 
Advanced search 
button 

This dialog box appears when clicking the Advanced search button in the Select 
Sample(s) for Evaluation dialog box. Here are defined the criteria to select the samples in 
the Measure.MDB database for one search. 
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Control Description 

Search raw data files 
(button) 

click this button to retrieve an SSD file without searching the database 

Sample list columns 
(button) 

display the Select Samples List Columns dialog box, where it is 
possible to choose the columns of the table 

Sample ID (check box 
and text field) 

to retrieve a sample by its name (as entered in LOADER): check the 
box and type the name in the text field 

it is possible to use the wildcards "?" (any character) and "*" (any 
character string including the empty string), e.g. "alu" can be found 
with "a*" and "a?u" 

Operators (radio 
buttons) 

Current: only the samples measured by the operator that is logged; 

Any: no filter 

Measured by: only the samples measured by the operator(s) selected 
in the list 

Evaluated by: only the samples evaluated by the operator(s) selected 

in the list 

Date and number 
options (radio buttons 

From ― to: only the samples measured between the two dates, or 
between the From date and today when the To box is cleared 

Measured today: only the samples measured today 

Current week: only the samples measured this week 

Past n days: only the samples measured during the last n days 

Past n samples: last n measured samples 

No date and number limitation: no filter 

Evaluation status Not yet evaluated (radio buttons): only display the samples that are 

not evaluated 

All samples (radio buttons): also display the samples that are already 
evaluated 

All occurrences of the same sample:  

Methods (radio 
buttons) 

Any:  no filter 

Selected: only the samples that were measured with the selected 
methods 

Not selected: only the samples that were not measured with the 
selected methods 

the two last options activate the list of measurement methods 

 

These options apply only as long as the Advanced Search dialog box is displayed. 

 

Select Samples List Columns 
This dialog box is used to set the columns that are displayed in the Select Sample(s) for 
Evaluation dialog box, i.e. the data that are shown for every sample. 

To display it: 

 in the Default Search Options dialog box or in the Advanced Search dialog box, click 
the Sample list columns button. 
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Control Description 

 
remove the selected column (in the right list) from the display 

 
insert the selected column (in the left list) from the display 

 
move the selected column (in the right list) up or down in the list; the 
column will be displayed one position left or resp. to the right 

OK validate the changes and close the window 

Cancel discard the changes and close the window 
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Column Description 

Added compound additive of the preparation 

Additive/Original mix ratio between the additive and the original material 

All elements WDX: in case of reference sample for drift correction: state of the 
MeasureAll field flag (set in the LOADER), 

1 = force the measurement of the elements that belong to the 
measurement method but that do not belong to the drift correction 
method 

C. Method calibration method (name of the FCL file) 

Color color of the sample as defined in LOADER 

Created by name of the operator that was logged at the time of the creation of the 
data in LOADER (can be different from Measured by) 

Creation date date and time when the data were defined in LOADER (the 
measurement is performed after the creation) 

Data life For control samples and type standard samples: duration stored in the 
Specification database, typed in the Validity (days) warning field 

Diameter sample diameter as defined in the preparation 

Dupl. duplicated, means that the sample was evaluated several times 

Eval. date date of the evaluation 

Evaluated whether he sample was evaluated or not 

Evaluated by name of the operator that was logged at the evaluation time 

F. Method format method (name of the WZM file) 

FCL/EVM file path and name of the application (EVM file) 

Is checked whether the sample was validated in QUERYRES (Results Monitor), 
with the Remove and validate button (see the related manual, 
section 3.2.3 "Managing the Result List") 

Is standard whether the sample is the standard of a calibration 

M. Method measurement method (name of the MM file) 

Meas. date date and time when the measurement of the sample ended 
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Column Description 

Measured whether the sample was measured or not; 

not measured means that the sample was created in LOADER, but 
the measurement is not finished yet 

Measured by operator that was logged when the measurement ended 

MM File path and name of the measurement method 

Position position of the sample on the sample loader when it was measured 

Preparation name of the preparation 

Qual std invalid When Quality Check is used: there was no valid  

Run time duration of the measurement 

SSD File path and name of the SSD file 

SSD Status exist or not; see the column "Measured" 

UID unique identifier of the sample in the database (16 bytes) 

WZM File path and name of the format method 

 

The program reads the name of the fields in the Measure.MDB database. Additional fields 
created by the user may appear. 
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C.2 Columns of the Quant window 

Select Quantitative Window Columns dialog box 
This dialog box is used to set the columns that are displayed in the Quant window, i.e. the 
data that are shown for every compound (see the sections 2.3.1 "The Quant window" and 
4.3.5 "Adjustable display parameters"). 

 
Quant columns 
button 

To display the Select Quantitative Window Columns dialog box: 

 select the Quant columns command in the View menu, 
— or — 
click the Quant columns button. 

 

Control Description 

 
remove the selected column (in the right list) from the display 

 
insert the selected column (in the left list) from the display 

 
move the selected column (in the right list) up or down in the list; the 
column will be displayed one position left or resp. to the right 

OK validate the changes and close the window 

Cancel discard the changes and close the window 

  

 

 

Description of the compound 

Column Description 

Formula Chemical formula of the compound 

Z atomic number of the key element of the compound (i.e. the heaviest 
element, the one which line is used to calculate the concentration) 
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Results 

Column Description 

Concentration concentration of the compound in the original material (before 
preparation); 

the unit is the one defined in the WZM file, otherwise the default unit is 
percent 

Prepared element concentration of the element in the measured sample; in case of a 
compound, only the concentration of the key element (i.e. the heaviest 
element of the compound) is displayed; 

the unit is the one defined in the WZM when the Use format method 
to display prepared element concentration box is checked 
(Evaluation Methods dialog box, Display tab), otherwise it is in 
percent 

Bound% concentration calculated by stoichiometry, when an element is linked 
to measured elements in a compound 

XRF% concentration calculated from the measured intensity 

Imbalance Bound% - XRF%, when an element is linked to measured elements in 
a compound 

The columns below are displayed three times, corresponding to the three lines that can be 
defined for a compound 

Calc. concentration when several lines are available for a compound, the different 
concentrations computed with each line are displayed in these 
columns 

Stat. error error on the concentration introduced by the fluctuation of the signal 
(Poisson's law); 

the error on the net intensity is calculated from the 3· of the gross 
intensity, background intensity and overlaid intensity  

LLD lower limit of detection 

90% line absorption thickness of the layer of the sample that absorbs 90% of the line, i.e. 
the layer that gives 90% of the signal for this line; 

when the sample is thinner, the "loss of intensity" is automatically 
corrected 
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Description of the line 

Column Description 

Line n name of the line 

Line energy energy of the photons of the radiation 

Wavelength wavelength of the radiation 

Peak position position of the peak 

Bkg. position position of the background in case of a peak/background method 

Tube kV high voltage of excitation of the X-ray tube 

Tube mA intensity of the current for the excitation of the X-ray tube 

Filter filter between the X-ray tube and the sample (material and thickness) 

Mask diameter of the mask  

Collimator aperture of the collimator, in ° 

Crystal crystal used for the analysis: LiF 200, LiF 220, OVO-55… 

Detector detector used for the measurement: proportional counter or 
scintillation counter 

PHA-UL — PHA-LL upper limit (UL) and lower limit (LL) of the discrimination (pulse height 
analysis, PHA) 

 

Description of the intensity 

Column Description 

Mode and drift corr. factor applied to the intensity to take the atmospheric mode and drift 
correction into account 

Raw peak raw intensity, corrected by the drift correction, the atmospheric mode, 
the absorption of the film (for liquids) and the overlaps 

Background background intensity, corrected by the drift correction, the 
atmospheric mode, the absorption of the film (for liquids) and the 
overlaps 

Net int. net intensity, corrected by the drift correction, the atmospheric mode, 
the absorption of the film (for liquids) and the overlaps 

Actual int. intensity written in the raw file, before any calculation or correction. 

Overlaid int. intensity from the neighboring peaks that contribute to the raw height 

Foil correction multiplication factor for the intensity to take the absorption by the film 
into account 

Peak/Bkg/Ovl 
deviation 

3 error, i.e. three times the square root of the intensities expressed 
in counts 

 

Raw int. = Actual int. × Mode and drift corr. × Foil correction 

Net int. = Raw int. - Overlaid int. - Background 
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C.3  Dialog boxes and menus related to the Quant windows 

Quantitative options 
This dialog box is used to set the parameters of the Quant window (layout) and of the 
quantitative evaluation. 

To display this dialog box: 

 while the active window is a Quant window, select the Options command in the View 
menu. 

 

 

Details view tab 

Control Description 

Multiple or single 
window option 

when displaying the Compound Details window (View details in the 

context-sensitive menu): 

 Display all "details" in the same window: there is only one 

Compound Details window; 

 Create a new floating window each time: there is one Compound 

Details window per compound; 

Update option This zone is active only when the Display all "details" in the same 
window option (see above) is checked 

 On request from the context menu: the content of the Compound 
Details window only changes when the View details command is 

chosen in the context-sensitive menu 

 Implicitly when the focus changes: the content of the Compound 

Details window changes every time another compound is selected 
(auto update) 

Scan views When displaying the spectrum in a Quali window: 

 Display element lines in scan view: the sticks of the lines 
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for the detected elements (i.e. which concentration is above 
0) are displayed 

 

 

Modes tab 

Control Description 

Automatically initialize calculation 
when data is loaded (check box) 

when this box is checked, there is no need to click the 
Initialize button (or to use the Quanti | Initialize menu 
option) after the importation of data 

Automatically run evaluation after 
successful initialization 

when this box is checked, there is no need to click the 
Compute button (or to use the Quanti | Compute menu 
option) after the initialization of the calculation 

Automatically initialize calculation 
after an interactive change 

Self-explanatory 

Display concentrations using 
WZM data 

When this box is checked, the unit (% or PPM) that is 
used is the one set in the WZM file 

Close Methods and Sample 
properties dialog box on Apply 

When this box is checked, the Apply button in these 
dialog boxes becomes Apply and close 

Display loader input data The LOADER input data are the data that are entered 
manually, depending on the definition file (e.g. LOI, mass 
before ignition etc.). 

Error handling options When these options are checked, the related errors are 
ignored 
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More modes tab 

Control Description 

Sum displayed compounds 
according to current display rules 

When this option is selected, the concentrations are 
summed as they are displayed.  

Sum all positive concentration 
compounds 

When this option is selected, only the positive 
concentrations are summed. 

Algebraic sum of compounds 
including calculated negative 
values 

When this option is selected, all the concentrations, even 
the negative ones, are summed. 
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Printing tab 

Control Description 

Print intensities 
(check box) 

in the peak/background method only: print the intensities next to the 
concentration 

Print margin (text 
boxes) 

type in the margins in centimeter 

Font (button) click this button to display the Font dialog box, where you can choose 
the font (e.g. Arial, Times New Roman etc.), the style (regular, italic, 
bold) and the size. 

Create temporary file 
(Temp_C) while 
storing results 

When a measurement is completed, the result of the automatic 
evaluation is stored in a temporary file, Temp_C.DAT. 

When this option is checked, this temp file is also created when the 
result of the evaluation is stored in the database Measure.MDB 

Execute user batch 
command while 
storing results 

The application (EVM file) can refer to a batch file, set in the User 
calc. field (usually a BAT file); this file is executed at the completion of 

the automatic evaluation after the measurement; 

When this option is checked, this file is also executed after an 
interactive evaluation, when storing the results in the database. 
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Evaluation Methods 
This dialog box is used to choose the files used for the quantitative evaluation (especially 
the application and calibration files), i.e. the ones used for the initial evaluation 
parameters. 

 
Toggle method 
bar button 
 

To display the Evaluation Methods dialog box: 

 click the Toggle method bar button 
— or — 
use the View | Evaluation methods menu option. 

 

 

Methods tab 

Control Description 

Model name of the application (EVM file), and possibly the path relative to 
the default directory 

Calibration name of the calibration (FCL file), and possibly the path relative to the 
default directory 

Meas. Method name of the measurement method (MM file), and possibly the path 
relative to the default directory 

Format method name of the format method (WZM file), and possibly the path relative 
to the default directory 

Modules lib name of the modules library (MLB file), and possibly the path relative 
to the default directory 

User calc name of the automatic script (BAT, VBS, JS… file) that must be run 
when saving to the database, and possibly the path relative to the 
default directory 

 (Browse button) 
click this button to retrieve the path and filename with the Open dialog 
box 
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Sample Properties 
This dialog box is used  

 
Sample properties 
button 

To display the Sample Properties dialog box: 

 choose the Sample properties command in the View menu 
— or — 
click the Sample properties button. 

 

Parameter Description and options 

Analyzed layer  Infinite thickness assumed: the sample thickness is greater then 
the analyzed thickness for every line; 

 Area density: the sample does not have an infinite thickness for 
every lines; the "thin sample" effect is determined with the area 
density, i.e. the mass of the sample divided by the analyzed area 
(in g/cm

2
); 

 Diameter/Finished mass: the sample does not have an infinite 
thickness for every lines; the "thin sample" effect is determined 
with the diameter of the sample (in cm, assuming a cylinder) and 
its mass (in g). 

Additive formula chemical formula of the additive (see the section 4.1.3 Preparation: 
foil, dilution and loss on ignition). 

 Added element not in sample: when this box is checked, the 

elements contained in the additive are forced to 0 
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Parameter Description and options 

Ratio dilution of the original material, expressed by the ratio between one 
of the following mass (see the section 4.1.3 Preparation: foil, dilution 
and loss on ignition): 

 Additive: mass of added material (Added-g); 

 Original: initial mass of sample, before preparation (Original-g); 

 Total: final mass of sample, i.e. Original + Additive (Finished 

Mass-g); 

Choose the ratio in the drop-down list and its value in the text box 
— or — 
type the initial mass of sample in the Original-g text box, ad the 
mass of additive in the Added-g text box. 

Loss on ignition for a Fused bead preparation only (see the section 4.1.3 
Preparation: foil, dilution and loss on ignition): 

 Ignited-g is the mass of original sample, after calcination; 

 Non-fused Total-g is the mass of uncalcinated sample+flux 

before the fusion; 

 Loss on ignition (% of original sample) is the LOI 

 

Insert compound 
The Insert Compound dialog box is used to add a compound during an evaluation. As the 
compounds evaluated by measured elements are already in the material, the 
concentration of these compounds must be either fixed or calculated by balance to 100%.  

This dialog box is displayed with the Quanti | Add compound menu option. 

 

Control Description 

Formula (text field) chemical formula of the compound 

Fixed (radio button) with this option, the concentration is fixed to a given value, typed in 
the Concentration text field 

Matrix (radio button) with this option, the concentration is calculated by balance to 100% 

Concentration (text 
field) 

active only when the Fixed option is checked;  

type the concentration in % in the text field 

OK (button) insert the compound and close the dialog box 

Cancel (button) close the dialog box without inserting the compound 
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Context-sensitive menu 
The Context sensitive menu provides tools that are specific to the environment or to a 
given object. 

To display the Context sensitive menu: click with the right mouse button anywhere in the 
list of compounds. 

 

Control Description 

View details display the Compound Details window 

Set not present fix the concentration to 0 

Set matrix the concentration is computed by balance to100% 

Fix concentration… the concentration is fixed to a given value 

Select name of the 
line 

the concentration is computed from the measured XRF spectrum 

Chg formula change the chemical formula of the compound 

Delete the compound is removed; it does not appear even when the Show 
all elements option is set 
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Compound Details window 

Field Description 

First line chemical formula of the compound, followed by the concentration and 
by the way the concentration is set : XRF (if it is computed), Fixed or 
Matrix) 

Element chemical symbol of the element; the key element (i.e. the line used to 
compute the concentration) is highlighted with a star 

Z atomic number of the element 

A atomic weight of the element, in g·mol
-1 

Fr weight fraction of the element in the compound 

FT weight fraction of the element inside this compound in the whole 
sample (it is the weight fraction of the compound times the weight 
fraction of the element in the compound) 
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C.4  Quali window 

XRF Lines 

 
Elements toolbar 
button 

To display the XRF Lines window: 

 click the Elements toolbar button 
or 
select the Elements toolbar command in the View menu; 

The XRF Lines window represents a periodic table of the elements. When an element is 
displayed (i.e. the sticks figuring the lines of the element are superimposed to the 
spectrum), its box is in light gray and its indicator is red. When an element is hidden (the 
sticks are not displayed), its box is in dark gray and the indicator is black. 

 

 

Control Description 

left (normal) click an 
element cell 

display or hide the sticks figuring the lines of the element on the 
display 

right click an element 
cell 

display the context-sensitive menu, with only one option: Check 
(display) or UnCkeck (hide) the element 
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Qualitative Options 
The Qualitative Options dialog box is used to set the default parameters of the qualitative 
evaluation and the display parameters. 

To display this dialog box: while the active window is a Quali window, select the Options 
command in the View menu. 

 

Color scheme tab 

Control Description 

Scan ranges  Same color for all except selected range: this highlights a 
single Range; 

 Same color for all except selected file: this highlights the 
Ranges belonging to the same SSD file; 

 Same color for same parameters: when only one SSD file 
is imported, this option allows a different color for each 
Range ; when several SSD files are imported, this allows to 
compare what can be compared; 

 Same color for same file order: the color depends on the 
order of the Range in the SSD file. 

Elements  Same color for same atomic number: all the sticks of a 
given Element have the same color; 

 Same color for same order of selection: the color of each 
stick is defined independently; the colors are stored (in the 
Windows® registry), so for the next samples to be 
processed, the color of a stick can be set just by selecting it, 
following the same color pattern. 
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Scan display tab 

Control Description 

Show calculated 
background 

display the background line 

Show measurement 
parameters in tooltip 

display the measurement parameters (tube high voltage, filter) 
used for the spectrum under the mouse pointer 

Show integral rate in 
tooltip 

display the total number of counts collected per second for the 
spectrum (it is he integral in energy of the spectrum) 

Hide non selected 
files by default 

when this box is checked, the View selection only button is 
pressed when creating the Quali window, the Hide inactive file 
option of the Quali menu is active; 

see the "View/Quali zone" table in the section B "Toolbar", and 
the "Quali menu" in the section A. 

Auto select the active 
quantitative sample 

when this box is checked, the sample being evaluated in a 
Quant window is set as selected. 

Intensity scale option Select the unit of the Y-scale. The scale itself (linear or square 
root) is set by the context-sensitive menu (right-click the Y axis, 
see section 5.5.2 topic “X- and Y-scale setup”). 

Status bar pane 1 or 
2 

Sets what is written in the status bar (text box at the bottom of 
the window). 

 

Note: the "tooltip" is the popup window that appears when the mouse pointer is let 
still on a curve. 
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Auto quali tab 

Control Description 

Peak search noise 
threshold 

the statistical noise is the square root of the number of counts of 
the background (Poisson's law); 

the peaks whose net height is less than k times this statistical 
noise are ignored; when the peak is higher, the element is 
considered as present (see the section 5.4.1 "Automatic 
evaluation"); 

k is the value in this text field 

Peak search energy 
window 

the peak search algorithm uses a Savitzky-Golay smoothing; this 
energy window is the width of the sliding interval used for the 
smoothing (see the section 5.4.1 "Automatic evaluation") 

Concentration limits 
for view lines 

when the concentration calculated in a Quant window is below 
this value, the line is not displayed when choosing the Show 
lines option of the Quali menu 

Align element lines 
height on range 

the height of the sticks figuring the lines are adjusted to the level 
of a spectrum (the spectrum can be different for each line), as 
defined by the option: 

 selected: the selected spectrum is used for all the lines 

 highest in selected file: for a given energy, the highest 
spectrum amongst the spectra which belong to the same 
SSD file as the selected spectrum 

 highest in the displayed files: for a given energy, the 
highest spectrum amongst the displayed spectra 
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The options defined here apply when selecting the Evaluation command of the Quali 
menu (see the section 5.4.1 "Automatic evaluation"). 

Quali filter tab 

Control Description 

 
Select: the element is part of the automatic qualitative search; 

it is displayed in the pop-up window (tooltip) when the mouse 
pointer is close to a position of one of its lines 

 
Discard: the element is excluded from the automatic qualitative 
search; 

it is present in the tooltip and thus can be easily added 
interactively 

 
No check: the element is excluded from the automatic 
qualitative search; 

it is not displayed in the tooltip 
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Labels tab 

Control Description 

Background color… change the color of the background of the labels (yellow by 
default) 

Font… change the font of the labels 

Auto label escape 
and sum peak 

when this box is cleared (default), the escape peaks (loss of 
energy of the photon due to the ionization of the detector) and 
sum peaks (artifact of the detector, pile-up of pulses) are not 
labeled by the Label lines command of the Quali menu 

Auto label minor lines when this box is cleared (default), only the K1, K1, L1, L1 

and M lines are labeled by the Label lines command of the 
Quali menu 
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Label 
The layout of a Label is defined in the Label dialog box. To display it: 

 right click anywhere on the graphic, except on a curve or on an Element stick, and 

 in the context-sensitive menu, select Insert label. 

 

 

Control Description 

Label (text field) type the text of the label in the text field 

Horizontal, 45 
Degrees, 90 Degrees 

orientation of the label, see the picture above 

OK create the label and close the dialog box 

Cancel close the dialog box without creating the label 
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C.5  General dialog boxes 

Print Setup 
The aim of the Print Setup dialog box is to set the parameters of the printout. 

To display it: 

 in the File menu, choose the Print Setup command 
— or — 
in the Print Preview dialog box, click Print. 

 

Control Description 

Name (drop-down 
list) 

when several printer are available (i.e. connected, possibly 
through a network, and installed on the computer), choose the 
printer in the drop-down list 

Properties (button) set the parameters of the printer 

Paper size and 
source (drop-down 
lists) 

when several trays or sources are available, choose the one you 
want to use 

Orientation Portrait or Landscape, as shown on the picture 

Network browse through the network for a remote printer 

OK print the document and close the dialog box 

Cancel close the dialog box without printing 
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Print Preview 
The Print Preview dialog box displays a preview of what will be printed. To display this 
dialog box: 

 in the File menu, choose the Print preview command. 

  

Control Description 

Print print the document 

Previous/Next 
(buttons) 

when there are several pages: display the previous or the next 
page 

Two pages/One page 
(buttons) 

display two pages one beside the other, or one page on the 
screen 

Zoom in/Zoom out 
(buttons) 

magnify or reduce the picture 

Close (button) close the window 
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Print 
The Print dialog box is used to print the current window. To display it: 

 select the Print command in the File menu 
— or — 
use the CTRL+P key combination 

 

Control Description 

Name (drop-down 
list) 

when several printer are available (i.e. connected, possibly 
through a network, and installed on the computer), choose the 
printer in the drop-down list 

Properties (button) set the parameters of the printer 

Print to file (check 
box) 

instead of printing the document, the data a restored in a PRN 
file 

Print range  All: print the whole document 

 Pages: when the document is made of several pages, it is 
possible to print one or a set of pages 

Copies it is possible to print several copies of the same document 

 Number of copies (spin box): self explanatory; 

 Collate (checkbox): when it is cleared, all the pages #1 are 
printed together, then all the pages #2… when t is checked, 
the documents are printed as separate documents 

OK (button) print and lose the dialog box 

Cancel (button) close the dialog box without printing 
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About Eval2 
The About Eval2 dialog box gives information about the version of EVAL2, especially the 
version number. 

To display it: 

 
AboutEval2 button 

 select the About Eval2 command in the Help menu 
or 
use the About Eval2 button. 

 

Control Description 

OK (button) close the window 

 




